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Module 2: Creating a Research Paper
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Objectives (1 of 2)

• Describe the M  L A (Modern Language Association) 
documentation style for research papers 

• vs. APA (American Psychological Association)

• Modify a style

• Change line and paragraph spacing in a document

• Use a header to number pages of a document

• Apply formatting using keyboard shortcuts

• Modify paragraph indentation
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Objectives (2 of 2)

• Insert and edit citations and their sources

• Add a footnote to a document

• Insert a page break

• Create a bibliographical list of sources

• Find text and replace text

• Use the thesaurus

• Check spelling and grammar at once

• Look up and research information

• Work with comments in a document
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Project: Research Paper
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MLA Documentation Style (vs. APA)

• Use 12-point Times New Roman font

• Double-spaced text on all pages of paper

• No additional blank space after each paragraph

• Using one-inch top, bottom, left and right margins

• Indent the first word of each paragraph one-half inch from 
the left margin

• At the right margin of each page, place a page number one-
half inch from the top margin

• On each page, precede the page number by your last name

• No separate title page needed

• Place your name and course information in a block at the 
top of the page, below the header, at the left margin
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Changing Document Settings (1 of 4)

• Start Word and Create a Blank Document

• Set page width & show formatting marks

• To Modify a Style

• Right-click the (normal, @ Home tab | Style group) to 
modify in the Styles gallery to display a shortcut menu 
related to styles

• Click Modify on the shortcut menu to display the Modify 
Style dialog box

• Make the desired changes to the style in the Modify Style 
dialog box, and then click the OK button to update the 
style ( Font & Size -> Times New Roman, 12, ‘Only in 
this document’) 
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Changing Document Settings (2 of 4)

• To Change Line Spacing

• Click the “Line and Paragraph Spacing, [Home | Paragraph]” 

button to display the Line and Paragraph Spacing gallery

• Click the desired setting (2.0) in the Line and Paragraph 

Spacing gallery to change the line spacing at the location of the 

insertion point
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Changing Document Settings (3 of 4)

• To Remove a Space after a Paragraph

• Click the “Line and Paragraph Spacing” button to display the 

Line and Paragraph Spacing gallery

• Click “Remove Space After Paragraph” in the Line and 

Paragraph Spacing gallery so that no blank space appears 

after paragraphs
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Changing Document Settings (4 of 4)

• To Update a Style to Match a Selection

• Right-click Normal in the Styles gallery to display a shortcut 

menu

• Click “Update Normal to Match Selection” on the shortcut menu 

to update the selected (or current) style to reflect the settings at 

the location of the insertion point
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Creating a Header (1 of 2)

• To Insert a Header

• Click INSERT in the ribbon to display the INSERT tab

• Click the HEADER button to display the Header gallery

• Click the down scroll arrow in the Header gallery to see the 

built-in headers

• Click Blank in the Header gallery
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Creating a Header (2 of 2)

• To Right-Align a Paragraph

• Click HOME on the ribbon to display the HOME tab

• Click the Align Right button to right-align the current paragraph (header)

• To Insert Text and Page Numbers

• Click Header & Footer Tools Design on the ribbon to display the Header 
& Footer Tools Design tab

• Type your last name and press SPACEBAR (“Yassie ”)

• Click the Page Number button to display the Page Number menu

• Point to the desired location (Current Position) on the Page Number 
menu to display the Current Position gallery

• Click the desired style (Plain Number)

• To Close the Header

• Click the “Close Header and Footer” button to close the header and 
switch back to the document text
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Typing the Research Paper Text (1 of 16)

• To Enter Name and Course Information

• To Click and Type

• Position the mouse pointer in the location where you want 

to type, in the center of the document window until a 

center icon appears below the I-beam

• Double-click to center the paragraph and mark the 

insertion point between the left and right margins

• Type the desired text (paper title) and then press the 

ENTER key to position the insertion point on the next line

• To Format the Text Using a Keyboard Shortcut

• Press CTRL-L to left-align the current paragraph 
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Typing the Research Paper Text (2 of 16)

• To Display the Rulers

• Click VIEW on the ribbon to display the VIEW tab

• If the rulers are not displayed, click the Ruler check box to 

place a check mark in the check box and display the horizontal 

and vertical rulers on the screen
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Typing the Research Paper Text (3 of 16)

• To First-Line Indent Paragraphs

• With the insertion point in the paragraph to be indented, 
drag the First Line Indent marker to the desired location 
(.5”) on the ruler to set the location for the first-line indent

• Type text and the first line is automatically indented
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Typing the Research Paper Text (4 of 16)

• To AutoCorrect as You Type

• Word provides an AutoCorrect feature that automatically 

corrects certain typing, spelling, capitalization, or grammar 

errors as you type a document
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Typing the Research Paper Text (5 of 16)

• To Use the AutoCorrect Options Button

• Position the mouse pointer in the text automatically corrected by Word 

to display a small blue box below the automatically corrected word

• Point to the small blue box to display the AutoCorrect Options button

• Click the AutoCorrect Options button to display the AutoCorrect 

Options menu

• Press the ESC to remove the AutoCorrect Options menu from the 

screen
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Typing the Research Paper Text (6 of 16)

• To Create an AutoCorrect Entry

• Click FILE on the ribbon to open the Backstage view

• Click Options in the Backstage view to display the Word 

Options dialog box

• Click Proofing in the left pane to display proofing options in the 

right pane

• Click the AutoCorrect Options button in the right pane to 

display the AutoCorrect dialog box

• When Word displays the AutoCorrect dialog box, type the word 

you want to replace in the Replace text box, and the word to 

replace with in the With text box

• Click the Add button

• Click the OK button (AutoCorrect dialog box)

• Click the OK button (Word Options dialog box)
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Typing the Research Paper Text (7 of 16)

• To Change the Bibliography Style

• Click REFERENCES on the ribbon to display the 

REFERENCES tab

• Click the Style arrow to display a Style gallery of 

predefined documentation styles

• Click the desired style (MLA) in the Bibliography Style 

gallery to change the documentation style
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Typing the Research Paper Text (8 of 16)

• To Insert a Citation for a New Source

• Click the Insert Citation button to display the Insert 

Citation menu (with the insertion point placed after 

“first two fingers”, 2nd par.)

• Click “Add New Source” on the Insert Citation menu to 

display the Create Source dialog box

• Click the “Type of Source” arrow, and then tap or click the 

type of source you are adding (Article in Periodical)

• Type the source information in the appropriate text boxes, 

and then click the OK button to insert the citation in the 

document at the location of the insertion point (Zhao, 

Shen Li; Technology Aches and Pains; Monthly 

Medical and Review; 2021; July;  ; n. pag. ;Web)

• Enter a period after “fingers” to end the sentence -19-



Typing the Research Paper Text (9 of 16)

• To Insert a Footnote

• Enter more text and place the insertion point after “injuries.” 

(end of 2nd par.)

• Click the Insert Footnote button [References | Footnotes grp] 

to display a note reference mark (a superscripted 1) in two 

places:

-(1) in the document window at the location of the insertion point 

and

-(2) at the bottom of the page where the footnote will be 

positioned, just below a separator line

• Enter the footnote text
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• To Insert a Citation Placeholder

• Used to insert a citation without entering the source 

information, which will be entered later

• Click the Insert Citation button to display the Insert 

Citation menu (with insertion point placed after 

“untreated” at the end of footnote.)

• Click “Add New Placeholder” on the Insert Citation menu 

to display the Placeholder Name dialog box

• Type the placeholder name (Clark), and then click the OK 

button

• Press the PERIOD key to end the sentence
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Typing the Research Paper Text (11 of 16)

• To Modify a Style Using a Shortcut Menu

• Footnote text style need to be modified to meet MLA style

• Right-click the text to display a shortcut menu

• Click Style on the shortcut menu to display the Style dialog box

• Select -> (Category: All style; Style: Footnote Text)

• Click Modify button to display Modify Style dialog box

• Select font size = 12 & line spacing = double space 

• Click the Format button to display the Format menu

• Click Paragraph on the Format menu to display the Paragraph 
dialog box

• Click the Special arrow (Indentation area) to select First line

• Click OK (Paragraph dialog box)

• Click OK (Modify Style dialog box)

• Click Apply (Style dialog box)
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Typing the Research Paper Text (12 of 16)

• To Edit a Source

• Assume you now have the source information for the citation 

• Click somewhere in the citation placeholder to be edited 

(Clark) to select the citation placeholder

• Click the Citation Options arrow to display the Citation Options 

menu

• Click Edit Source on the Citation Options menu to display the 

Edit Source dialog box

• If necessary, click the “Type of Source” box arrow and then 

select the type of source (Book)

• Enter the source information, and then click the OK button 

(Author: Clark, Addison Lee ;  Nadeer, Aisha Sati;  Title: 

Repetitive Strain Injuries; Year: 2021; City: Boston; 

Publisher: Lighthouse Publishing; Medium: Print)
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Typing the Research Paper Text (13 of 16)

• To Edit a Citation

• Click somewhere in the citation to be edited (Clark and 
Nadeer), which selects the citation and displays the 
Citation Options arrow

• Click the Citation Options arrow to display the Citation 
Options menu

• Click Edit Citation on the Citation Options menu to display 
the Edit Citation dialog box

• Change the information as necessary in the Edit Citation 
dialog box, and then click the OK button (Pages: 65-66)

• Click Author and Title check boxes

• Click OK to close the dialog box
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Typing the Research Paper Text (14 of 16)

• To Count Words (Enter More Text First)

• Click the Word Count indicator on the status bar to display 
the Word Count dialog box

• If necessary, place a check mark in the “Include textboxes, 
footnotes and endnotes” check box

• Click the Close button to close the dialog box

• To Insert a Citation Placeholder

• Place insertion point after “hearing loss ” (end of 3rd par.)

• Click the Insert Citation button (Reference tab)

• Click ‘Add New Placeholder’ on the Insert Citation menu

• Type Sanchez as the name tag on Placeholder Name box

• Click OK to close the dialog box.

• Enter a PERIOD to end the sentence
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Typing the Research Paper Text (15 of 16)

• To Hide and Show White Space

• To see the entire third paragraph, do the following:

• Position the pointer in the document window in the space 

between pages so that the pointer changes to a “Hide 

White Space” button

• Double click to hide the white space

• Position the pointer in the document window on the page 

break between pages so that the pointer changes to a 

“Show White Space” button

• Double click to show the white space
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Typing the Research Paper Text (16 of 16)

• To Edit a Source (for placeholder Sanchez)

• Click somewhere in the citation to be edited (Sanchez) to 
select the citation

• Click the Citation Options arrow to display the Citation 
Options menu

• Click Edit Source on the Citation Options menu to display 
the Edit Source dialog box

• Change the information in the Edit Source dialog box 
(Type of Source: Web site; Author: Sanchez, Jorge 
Mario; Name of Web Page: Technology and Your 
Hearing; Year/Month/Day Accessed: 2021/Oct./1; 
Medium: Web )

• Click OK to close the dialog box and create the source
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Creating an Alphabetical Works Cited 
Page (1 of 3)

• What is a Works Cited Page

• According to MLA format, the works citied page is a 

separate numbered page with the title, “Works Cited”, 

centered one inch from the top margin.

• To Insert a Page Break

• Position the insertion point where you wish to insert the 

page break (end of the text of research paper) 

• Click INSERT on the ribbon to display the INSERT tab

• Click the Page Break button to insert a manual page 

break immediately to the left of the insertion point and 

position the insertion point immediately below the manual 

page break
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Creating an Alphabetical Works Cited 
Page (2 of 3)

• To Apply a Style

To bring “First Line Indent” marker back to the left margin:

• Click HOME on the ribbon to display the HOME tab

• With the insertion point in the paragraph to be modified, 
click the desired style in the Styles gallery (Normal)

• Enter “Works Cited” as the title at the center (CTRL-E)
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Creating an Alphabetical Works Cited 
Page (3 of 3)

•To Create a bibliographical Reference List

• Press ENTER to move insertion point to the 
beginning of the next line and left aligned (CTRL+L)

• Click References tab

• Click the Bibliography button to display the 
Bibliography gallery (with insertion point placed in the 
beginning of the line below the title) 

• Click Insert Bibliography
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Proofreading and Revising the Research 
Paper (1 of 14)

• To Edit a Source Using the Source Manager Dialog 
Box

• Click the Manage Sources button (Reference tab | Citation 
Bibliography group) to display the Source Manager dialog 
box

• Click the source you wish to edit in the Current List (Zhao)

• Click the Edit button to display the Edit Source dialog box

• Make the desired changes to the source (delete ‘and’ from 
Periodical Title), and then click the OK button

• If a dialog box appears, click Yes to update all occurrences 
of the source

• Click the Close button to update the list of sources in the 
document and close the dialog box
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Proofreading and Revising the Research 
Paper (2 of 14)

• To Update a Field

• Right-click anywhere in the bibliography text to display a 

shortcut menu related to fields

• Click Update Field on the shortcut menu to update the 

selected field
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Proofreading and Revising the Research 
Paper (3 of 14)

• To Open the Navigation Pane

• Click VIEW on the ribbon to display the VIEW tab

• Place a check mark in the Navigation Pane check box 
[Show group] to open the Navigation Pane on the left side 
of the Word window

• If necessary, click the PAGES tab in the Navigation Pane 
to display thumbnails of the pages in the document

• To Go to a Page

• Open the Navigation Pane

• Scroll to and then click the thumbnail of the desired page 
(page 1)
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Proofreading and Revising the Research 
Paper (4 of 14)

• To Insert a Citation Using an Existing Source

• Position the insertion point at the location (end of 5th 
sentence ‘keyboard’ of 2nd paragraph) for the citation

• Click REFERENCES on the ribbon to display the 
REFERENCES tab

• Click Insert Citation button to display the Insert Citation 
menu

• Click the first source listed (Clark and Nadeer) on the 
Insert Citation menu to insert a citation for the existing 
source at the location of the insertion point
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Proofreading and Revising the Research 
Paper (5 of 14)

• The citation just entered is not in the correct location 

and needs to be moved to the end of the next 

sentence (‘repetitive strain injuries’)

• To Move a Citation

• Click somewhere in the citation to be moved to select it

• Position the pointer on the citation tab (3 dots on the left) 

until the pointer changes to a left-pointing block arrow

• Drag the citation tab to the location where the selection 

citation is to be moved (after “repetitive strain injuries”)

• Release the mouse and the citation is moved

• Delete any extra spaces
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Proofreading and Revising the Research 
Paper (6 of 14)

• To Find Text

• Click Home tab

• Click the Find button [Editing group] to display the 

Navigation Pane

• If necessary, click the Results tab in the Navigation Pane

• Type the text to find (‘auditory’) in the Navigation Pane 

Search box to display all occurrences of the typed text, 

called the search text, in the Navigation Pane and to 

highlight the occurrences of the search text in the 

document window
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Proofreading and Revising the Research 
Paper (7 of 14)

• To Replace Text

• Click the Replace button [Home tab | Editing group] to 

display the Replace sheet in the Find and Replace dialog box

• Type the text to find (auditory) in the Find what box

• Type the text to replace (listening) in the Replace with box

• Click the Replace All button to instruct Word to replace all 

occurrences of the Find what text with the Replace with text. 

If Word displays a dialog box asking if you want to continue 

searching from the beginning of the document, click the Yes 

button

• Click the OK button

• Click the Close button
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Proofreading and Revising the Research 
Paper (8 of 14)

• To Use the Thesaurus

• Right-click the word for which you want to find a synonym 

to display a shortcut menu (2nd occurrence of 

‘continual’ in the 2nd paragraph)

• Point to Synonyms on the shortcut menu to display a list 

of synonyms for the word you right-clicked

• Click the synonym you want (frequent) on the Synonyms 

submenu to replace the selected word in the document 

with the selected synonym
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Proofreading and Revising the Research 
Paper (9 of 14)

• To Check Spelling and Grammar at Once

• Press CTRL+HOME because you want the spelling and 

grammar check to begin from the top of the document

• Click REVIEW on the ribbon to display the REVIEW tab

• Click the Spelling & Grammar button to begin the spelling 

and grammar check at the location of the insertion point, 

which in this case, is at the beginning of the document

• Click the desired spelling in the list of suggestions

• If items are found, click the desired selection

• Click to close the dialog box
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Proofreading and Revising the Research 
Paper (10 of 14)

• To Look Up Information

• Select the word you want to look up – search the web for 

information (headphones or earbuds – 3rd par / 1st line)

• Click References on the ribbon to display the References 

tab

• Click the Search button [Research group]

• Search results will be displayed on the search pane.

• Click the Close button to close the pane
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Proofreading and Revising the Research 
Paper (11 of 14)

• To Use Researcher

• Click the Researcher button [References tab | Research 

group] to open the Researcher pane – search web for 

reference and source information

• With the Find Sources tab selected in the Researcher pane, 

scroll through the information and images that appear in the 

pane

• Type the words (carpal tunnel syndrome) in the search 

box in the Researcher pane and press ENTER to display 

topics an sources related to the search text

• Point to the + symbols to read the topics and their functions

• Click the Close button in the Researcher pane
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Proofreading and Revising the Research 
Paper (12 of 14)

• To Change the Zoom to Multiple Pages

• Click HOME on the ribbon to display the HOME tab

• If the “Show/Hide ¶” button is selected, click it to hide 

formatting marks

• Click VIEW on the ribbon to display the VIEW tab

• If the rulers are displayed, click the Ruler check box to 

remove the check mark from the check box and remove 

the horizontal and vertical rulers from the screen

• Click the Multiple Pages button to display the all three 

pages at once in the document window

• When finished, click the Page Width button to return to 

the page width zoom
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Proofreading and Revising the Research 
Paper (13 of 14)

• To Change Read Mode Color

• Click the Read Mode button on the status bar to switch to 

Read mode

• Click the VIEW tab to display the VIEW menu

• Point to Page Color on the VIEW menu to display the 

Page Color menu

• Click the desired color on the Page Color submenu to 

change the color of the Read mode screen

• When finished, click the Print Layout button on the status 

bar to return to the Print Layout view
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Proofreading and Revising the Research 
Paper (14 of 14)
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Working with Comments in a 
Document (1 of 6)

• To Insert a Comment

• Select the text to which the comment applies (last 

sentence of second paragraph)

• Click Review Tab

• If the Display for Review box (Tracking group) does not 

show Simple Markup, click the Display for Review arrow 

and then click Simple Markup on the Display for Review 

menu to instruct Word to display a simple markup

• If the Show Comments button (Comments group) is not 

selected, click it to select it

• Click the New Comment button to display a comment 

balloon in the markup area in the document window

• Type the comment (‘Let’s cover the hand and arm 

exercise in our brochure for patients.’) -45-



Working with Comments in a 
Document (2 of 6)

• To Go To a Comment

• Click the Previous button which causes Word to locate 
and select the previous comment in the document
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Working with Comments in a 
Document (3 of 6)

• To Edit a Comment in a Comment Balloon

• Click the comment to select it

• Click Edit comment (pencil icon)

• Position the insertion point in the comment at the location 
of the text to edit it (add ‘examples of’ after ‘Let’s cover’)

• Post the new text
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Working with Comments in a 
Document (4 of 6)

• To Reply to a Comment

• Click the comment to which you wish to reply so that the 
comment is selected

• Click the Reply button in the selected comment to display 
a reply comment for the selected comment

• Type an indented reply comment (‘Excellent idea!’)
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Working with Comments in a 
Document (5 of 6)

• To Hide and Show Comments

• If the Show Comments button is selected, click it to 

deselect it, which hides comments in the document

• Click Show Comments button again to show comments in 

the document or

• Click the comment icon to display associated comment

• Click the Show Comments button to hide comments again
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Working with Comments in a 
Document (6 of 6)

• To Delete a Comment

• Position the insertion point in the comment to delete

• Click the Delete button (Review tab | Comments group) to 

remove the comment containing the insertion point from 

the markup area

• To Delete All Comments

• Click the Delete arrow to display the Delete menu

• Click Delete All Comments in Document on the Delete 

menu to remove all comments from the document
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